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ABSTRACT

FORMATION OF SILICON NANOCRYSTALS BY
LASER PROCESSING OF SILICON RICH OXIDES

Sinan Gündoğdu

M.S. in Physics

Supervisor: Prof. Dr. Atilla Aydınlı

August, 2012

Silicon nanocrystals are well known to exhibit strong luminescence in the visi-

ble. Extension of this into a nanocrystal network would be beneficial for many

applications. In the light of recent advances on exciton-plasmon interactions and

photovoltaic cells, there is renewed interest in the use of nanostructures. Due to

quantum confinement, silicon nanoclusters with increased band gaps, are promis-

ing for down conversion light and enhanced emission on plasmonic surfaces. Con-

ventional techniques utilize high-temperature processing to obtain the Si-SiO2

phase separation which uses high thermal budget, not suitable for localized ap-

plications not compatible with glass substrates or thin-film stacked structures.

An alternative approach capable of avoiding high temperature processing is laser

irradiation of substochiometric amorphous silicon oxides.

In this work, continuous-wave laser processing of Si-rich oxide thin films with

varying Si content were performed in order to obtain Si nanocrystals embedded in

silica. The role of composition, dwell times and power densities were investigated

for Si-SiO2 phase separation.

We present cw laser processing of PECVD grown and sputtered SiOx films.

XPS, RBS and ERDA techniques were used for the stoichiometry analysis of dif-

ferent composition as grown samples and their optical properties were determined

through ellipsometry analysis. Processing was performed with an Ar+ laser at

488 nm. The structural changes due to processing were investigated by Raman

and photoluminescence spectroscopy. It has been shown that silicon nanocrystals

formation depends both on precursor gas composition (hydrogen-diluted SiH4 and

N2O or CO2 gases) and on laser power density. PECVD grown hydrogenated SiOx

films were compared with sputtered films with and without hydrogen to identify

the role of hydrogen for phase separation.
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ÖZET

SILISYUM ZENGINI OKSITLERIN LAZERLE
İŞLENMESIYLE SILISYUM NANOYAPILARIN

OLUŞUMU

Sinan Gündoğdu

Fizik, Yüksek Lisans

Tez Yöneticisi: Prof. Dr. Atilla Aydınlı

Ağustos, 2012

Farklı silisyum oranlarına sahip silisyum zengini ince filmler sönümsüz dalga laz-

eriyle tavlanarak silika içine gömülü silisyum nanokristaller elde edildi. Kimyasal

bileşimin, ışınlama süresinin, ve lazer güç yoğunluğunun Si-SiO2 faz ayrışmasına

olan etkisi incelendi.

Son yıllarda fotovoltaik hücrelerdeki son gelişmelerle birlikte elektromanyetik

tayfın daha verimli bir şekilde kullanılması için nanoyapılara olan ilgi de artmıştır.

Kuantum hapsolma etkisi sayesinde nanoyapıların bant aralığı artar. Böylece

yüksekışığın aşağı çevrimi (Enerjisinin düşürülmesi) mümkün olur. Gelenek-

sel yöntemde Si-SiO2 faz ayrışması için yüksek sıcaklıkta tavlama işlemi uygu-

lanır. Bu işlemler cam alttaşlara ve seri üretimde kullanılan ince film teknolo-

jisine uygun değildir. Yüksek sıcaklık yöntemine alternatif bir yaklaşım lazerle

ışınlamadır.

Bu çalışmada plazma takviyeli kimyasal buharı biriktirme (PECVD) ve

saçtırma yöntemleri ile üretilen SiOx ince filmler sönümsüz dalga lazeriyle

tavlanmıştır. Tavlanmamış örneklerin bileşimi x-ışını fotoelektron spek-

troskopisi(XPS), elastik geri tepme deteksiyonu ERDA, ve Rutherford geri

saçılma spektroskopisi (RBS) teknikleri ile, optik özellikleri ise elipsometri anal-

iziyle belirlendi. Tavlama argon iyon lazerinin 488 nm dalgaboyu kullanılarak

gerçekleştirildi. Tavlama sonucu oluşan yapısal etki Raman ve fotolüminesans

spektroskopisiyle incelendi.

Silisyum nanokristallerin boyut ve miktarının oluşturma gazlarının (Hidro-

jenle seyreltilmiş SiH4 ve N2O ya da CO2) akış hızına ve lazer güç yoğunluğuna

bağlı olduğu gösterildi. Hidrojenin faz ayrışmasındaki rolünü incelemek için
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PECVD ve saçtırma ile hazırlanan filmler karşılaştırıldı.

Anahtar sözcükler : Silisyum zengini oksitler, ince film, lazerle tavlama.
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Chapter 1

Introduction

Silicon nanoparticles are of great interest due to their optical properties and

potential applications in semiconductor industry. Some of these applications

include light emitting diodes [1], non-volatile memories [2], and 3rd generation

solar cells [3, 4]. Efficient light emission from silicon nanocrystals makes them

a good candidate for silicon based lasers. The indirect band gap of bulk silicon

hinders such a possibility. However, when silicon is reduced in dimensionality,

its light emitting shows blue shift and emits in the visible. The light intensity

is quite large compared to bulk case. Such a source of excitons can be used

along with surface plasmons to enhance the emission which may also lead to a Si

based plasmonic laser. Studying exciton-plasmon coupling on flat and corrugated

metallic surfaces may serve towards this goal.

3rd generation solar cells aim to decrease the cost per produced energy by

either increasing the efficiency, or decreasing the cost of production of the cell.

Two mechanisms that lowers the efficiency are inability to absorb the photons

with energies below the band gap and loss of photonic energy due to thermalisa-

tion of the excess carrier energies energies above band gap. To solve this problem,

one strategy is to make multi band gap or tandem solar cells [5, 3]. Due to the

confinement effect, silicon nanoparticles have wider band gaps than bulk silicon.

This property makes it an ideal material for tandem solar cell. In this design

an upper layer of silicon nanoparticles absorb high energy light while the bottom

1



bulk silicon solar cell absorb the low energy light.Traditional method to obtain

silicon nanostructures out of silicon rich oxide is to anneal it in high temperature

furnace[2]. However, inserting the whole sample into a high temperature furnace

is not suitable for current thin film solar cell technology. We are using an al-

ternative laser irradiation method that locally heats the thin silicon rich oxide

film.

Silicon rich oxides are materials that consist of silicon and oxygen with oxygen

to silicon ratio lower than 2. Depending on this ratio, excess silicon may aggregate

in the form of silicon nanoparticles within silicon dioxide. If this value is close

to 1, a silicon sponge-like structure in silicon dioxide is expected [2]. This mate-

rial consist of a network of nanowires, therefore it is electrically percolated and

due to its nanowire structure its energy levels are expected to exhibit quantum

confinement phenomena [6].

Figure 1.1: Flowchart of this study

Main scope of this work is to analyze the effect of composition of the films

and laser power on the nanocrystalline silicon formation which may be used in

plasmon-exciton interactions and solar cells. A flowchart is given in figure 1.1. In
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this study we deposited silicon rich oxide thin films by Plasma Enhanced Chem-

ical Vapor Deposition (PECVD) and sputter deposition methods. For PECVD,

we used 2% silane diluted in hydrogen as silicon source and N2O or CO2 as oxy-

gen source. For this reason we expected our films to contain hydrogen, nitrogen

and carbon as well as silicon and oxygen. To focus on the effect of hydrogen, we

produced two types of sputtered samples: one was sputtered by argon, the other

was sputtered by argon mixed with hydrogen. For composition analysis of the as

grown films we used Elastic Recoil Detection Analysis (ERDA), X-ray Photoelec-

tron Spectroscopy (XPS) and Fourier Transform Infrared Spectroscopy (FTIR).

Optical characterisation was done by Variable Angle Spectrometric Ellipsometry

(VASE). Laser processing was done in an inverted microscope focusing a 488 nm

argon-ion laser beam on the film coated on silicon and fused silica substrates.

Laser spot size was between 2-10 µm. Output of the microscope was coupled

to a high resolution monochromator, so we could irradiate the samples and ob-

tain the Raman spectra in the same setup. We scanned the samples by a step

motor controlled X-Y stage mounted on the microscope during irradiation. We

also annealed the samples in a furnace to compare the phase seperation temper-

atures. Crystalline silicon formation was observed and characterised by Raman

spectroscopy.

In the next Chapter, we will discuss the motivation and the background of

this study and the modeling of the laser heating system by Comsol Multiphysics.

Chapter 3 lists the methods used to characterize the unprocessed samples. Chap-

ter 4 explains the laser processing method and the raman characterization of the

laser annealed zones as well as the furnace annealed samples. In Chapter 5 we

will summarize the results of the characterization and laser processing.
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Chapter 2

Background

Silicon rich oxides (SRO) are a type of oxide that has excess silicon. A con-

ventional expression is the SiOx formulation. When x=2 it is considered to be

stochiometric. For silicon rich oxides x is smaller than 2. Due to being non sto-

chiometric, these oxides tend to separate into two energetically more favorable

phases; SiO2 and Si. This process is dependent on temperature, annealing time,

and the number x. Phase separation may follow these steps: nucleation, growth,

Ostwald ripening and spinodal decomposition. Nucleation phase is the beginning

of the formation of silicon seeds in SRO [7, 8]. These seeds grow by diffusion

of more silicon atoms in the growth phase. Ostwald ripening is the merging of

the seeds to form larger structures to minimize the surface energy. If the excess

silicon is high enough spinodal decomposition occurs. Spinodal decomposition is

the separation of the material into two distinct phases (In our case Si and SiO2)

[7, 8, 9, 10, 11]. These two phases are not localized like nucleation, but uniformly

distributed forming a sponge-like (or network-like) structure. Phase separation

occurs as a result of multiple interactions between atoms including bond break-

ing, chemical reactions, and diffusional jumps [7, 8]. To break the existing bonds,

an activation energy is needed. The activation energy may be supplied by heating

the SRO. If kT is in the order of the activation energy, the bonds may break, and

if the decomposed state is energetically more favorable, the system reaches to a

new equilibrium.
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Kinetic Monte Carlo simulations of similar phase separation exists in the

literature [7, 2]. Figure 2.1 shows the time evolution of the phase separation.

In this study low energy Si+ ions were implanted into SiO2. (a), (b), and (c)

shows different Si+ fluencies ((a) is lowest and (b) is highest). Activation energy

is supplied by the kinetic energy of the accelerated ions. At low fluencies the

system evolves into Si particles embedded inside SiO2 (Figure 2.1(a). At first,

nucleation occurs, then gradually these nuclei grow larger. Small nuclei merge to

form larger nanoparticles (Ostwald ripening). Higher ion beam fluencies results

in larger nuclei (b). Here, the particles that are non-spherical at first evolves into

spherical particles. At even higher ion beam fluencies spinodal decomposition

occurs and silicon nanoparticles form a kind of network. Finally the system evolve

into silicon nanoclusters embedded in SiO2. Figure 2.2 shows the simulation

results((b) and (d)) with scanning transmission electron microscope of actual

samples ((a) and (c)). (a) and (b) are low fluence samples and exhibits nucleation

(white spots are silicon nanoparticles) while (c) and (d) are high fluence samples

that exhibit spinodal decomposition (silicon nanoclusters form a network-like

structure). We observe a tendency to form worm-like nanostructures at the higher

ion beam fluence. The SEM images are in good correlation with their calculated

counterparts.

Spinodal decomposition is particularly interesting due to its sponge-like per-

colated structure. Percolation gives one the opportunity to manufacture p-n or

p-i-n junctions out of p-type and n-type silicon sponges. Another advantage of

the sponge-like silicon is its wide band gap. Due to quantum confinement, its

band gap is wider than bulk silicon [12]. One of the factors that lowers the solar

cell efficiencies is the thermalization of high energy photons. These photons have

energies higher than the band gap, therefore the electron excited by one of them

would have an energy higher than the conduction band minimum. The excess

energy may be converted into phonons causing heating. However, in a tandem

configuration (e. g. a silicon solar cell coated with p-n junction of sponge-like

silicon) high energy photons may be absorbed by sponge-like silicon and low en-

ergy photons by silicon solar cell for efficient use of solar spectrum and reducing

heating due to thermalization.
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Sponge-like silicon also has potential to enhance the absorbtion of light due

to its textured structure. In our case it is also embedded in SiO2 which provides

passivation by reducing dangling bonds. These dangling bonds cause intermediate

states between the band gap and the conduction band. Electrons and holes

produced by the absorbed light may recombine easily over these intermediate

states. For silicon, oxidation removes these states, therefore surface of the silicon

is passivated by oxygen or sulphur. Due to being embedded into silicon dioxide

as a whole, silicon nanostructures produced by our method have an effective

passivation [13].
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Figure 2.1: Kinetic Monte Carlo calculations of low energy Si+ ion implantation
into SiO2.
Reproduced with permission from Appl. Phys. Lett. 81(16):3049, 2002. Copyright 2002 American Institute of

Physics.
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Figure 2.2: STEM images ((a) and (b)) and Kinetic Monte Carlo calculations
((c) and (d))of ion implanted samples.
Reproduced with permission from Appl. Phys. Lett. 85(12):2373, 2004. Copyright 2004 American Institute of

Physics.

.
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2.1 Heat Transfer Simulation

Figure 2.3: Schematics of numerical simulation of temperature rise during laser
irradiation. (a) Scan geometry, (b)Finite element discretization (c) laser spot
(top), (d) laser spot (sideways)

Annealing temperature plays an important role on formation of silicon

nanoparticle formation in SRO. In the case of furnace annealing, temperature

can be measured easily, yet it is a difficult task to measure the temperature on

the laser processed zones during the process. It is possible to calculate the tem-

perature that the film reach approximately, given the laser power, laser spot size,

and optical and thermal properties of the sample. In this section, calculation of

heating of silicon rich oxide thin film on a silica substrate by a laser is explained.

We simulated the heating of a film coated sample by a moving laser beam

by Comsol Multiphysics Conductive Heat Transfer Module. Using finite element

9



method, this software solves the heat transfer equation:

ρCp
∂T

∂t
+∇(̇− k∇T ) = Q

where Cp is the specific heat capacity, ρ is the density, k is the Boltzmann constant

and Q is the heat source term. In our case, the laser beam is absorbed by the film

and the intensity of the laser decays exponentially into the film. Heating occurs

via absorption of light. Therefore, we have to add the laser beam as a heat source

into the equation. To do this we have to calculate how much light is absorbed by

the film. Assuming absorption is constant (i. e. not dependent on temperature

or light intensity) laser intensity obeys Beer-Lambert law:

I(z) = I0e
−αz

where I0 is the initial power density and α is the absorbtion coefficient. Absorb-

tion coefficient depends on the wavelenght of the light, λ, as well as the complex

component of the refractive index k:

α =
4πk

λ

Initial power density also varies spatially, assuming our laser has a Gaussian beam

profile, I0 should be:

I0(x, y) =
Itotal
σπ

e−(x2+y2)/σ2

It is normalized so that the total initial power is Itotal. σ is the beamwidth. If

the beam is moving in the x direction the intensity should be time dependent.

I0(x, y, t) =
Itotal
σπ

e−((x−vt)2+y2)/σ2

Inserting the intensity we found into Beer Lambert law we find that the heat

source term due to the laser absorbtion should be:

Q = 4kItotale
−(4πkz)/λe−(x−w∗t)2+y2)/σ2)/(λb2)

Comsol Multiphysics uses finite element method to solve the heat transfer

equation. It divides the given structure into discrete parts called a polygon mesh.

Therefore it reduces the continuous equation into finite number of elements. The
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more the number of these pieces, the better the precision. However, high number

of element cause long calculation time. To solve this, a common technique is to

make the mesh denser in the point of interest and sparse in other places. In our

case, the point of interest is the line that the focused laser beam moves over.

Parameter Value
Laser power 100 mW
Scan speed 0
Beamwidth 80 µm
Extinction coefficient 0.025 cm−1
Wavelength 488 nm
Film thickness 300 nm
emissivity 6 0.92

Table 2.1: Parameters used in Comsol simulation.

The structure simulated is shown in figure 2.3(a). In figure 2.3(b) how the

mesh density varies on the structure is shown. It gets denser on the scanned

line and the film surface. We have defined the film thickness to be 300 nm and

the substrate to be 100 µm. Our actual substrates is around 1mm thick, but

we saw that temperature drops to almost 300 K after 80 µm. The extinction

coefficient k is measured by ellipsometry for our films and it was assumed to be

zero for SiO2 substrate. Temperature dependent thermal conductivity and heat

capacity was selected as SiO2 for both the film and the substrate. To understand

the time dependence of the temperature we calculated a beam that is suddenly

turned on but not moving on the sample. The parameters are given in Table

2.1. We calculated the time dependence of the temperature at the center of

the beam with varying beamwidth and the laser power. In figure 2.5 different

incident powers, in figure 2.4 different beamwidths are shown while all other

parameters are kept as in table 2.1 . We see that the system reaches to an

equilibrium temperature after about 100 µs. Our experimental scan speeds are

between 50 µm/s and 1000 µm/s so the corresponding dwell times for 10 µm

beamwidth are 0.2 s and 0.01 s. We therefore expect the scan speed dependence

of the induced maximum temperature during the scan to be negligible for this

range of dwell times. However, scan speed determines the dwell time and the
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Figure 2.4: Temperature at the laser spot center as a function of annealing time
for different beamwidths. Laser power is 100mW.

crystallization ratio, as we will see in the 4th chapter. Figure 2.6 shows the

equilibrium temperature when the beamwidth is constant. A linear relationship

between the temperature and the beamwidth is observed. Figure 2.7 shows the

equilibrium temperature of the center when the beamwidth is varied but total

power is held constant. Same amount of total heat diffused faster when it is

confined in a smaller space, due to the higher temperature difference between

the heated zone and the environment. This explains the exponential decay form

in figure 2.7. Figure 2.3(c) shows the temperature plot from the top view (in

the z direction). Temperature is maximum at the center and the heat radially

dissipates to the film. Figure 2.3(d) is the temperature plot in the cross section

view, heat penetrates into the substrate by 10-20 µm (full width at half maximum

of temperature).
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Figure 2.5: Temperature at the laser spot center as a function of annealing time
for different laser powers. Beamwidth is 10 microns.

Figure 2.6: Equilibrium temperature at the laser spot center as a function of
power density. Laser power is 100 mW.
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Figure 2.7: Equilibrium temperature at the laser spot center as a function of
power density. Laser beamwidth is 20 µm.
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2.2 Conclusion

In this chapter we have explained the mechanism of silicon nanocluster formation

in a silicon rich oxide. Excess silicon forms nanoclusters inside silicon dioxide

via nucleation, Ostwald ripening and spinodal decomposition. For nanocrystal

formation, an activation energy is needed and this energy is supplied by heat-

ing. A possible way of heating is laser processing. Laser light is absorbed by the

film producing heat. The heat dissipates according to the heat transfer equation.

We have explained a method for simulation of such a system by Comsol Multi-

physics. We found that the maximum temperature depends on the spot size and

laser power. The Comsol study gives us rough guidelines and trends for induced

temperatures as a function of laser power and spot size. As we do not know the

exact temperature induced during the experiment it is not possible to compare

the results of the Comsol study wit experiment on an absolute scale. A tutorial

for Comsol Multiphysics is supplied in Appendix A. Similar systems can be mod-

eled by the method explained here. In the next chapter, we will explain the thin

film growth methods by PECVD and sputter deposition and characterisation of

the as-grown samples by ERDA, XPS, FTIR and ellipsometry.
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Chapter 3

Sample Preparation and

As-Grown Characterisation

We prepared 5 groups of samples by the following methods:

1. PECVD with SiH4:H2 and N2O

2. PECVD with SiH4:N2 and N2O

3. PECVD with SiH4:H2 and CO2

4. Sputtering SiO2 with Argon

5. Sputtering SiO2 with Argon and Hydrogen

In this section we will explain PECVD and sputtering methods and analysis of

as-grown films by ERDA, XPS, FTIR and ellipsometry.
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3.1 Sample preparation

3.1.1 Preparation of SiOx by PECVD

Plasma Enhanced Chemical Vapor Deposition (PECVD) is a method for man-

ufacturing thin films at relatively low temperatures. A schematic is shown in

figure 3.1. A gas mixture flows into a chamber which is vacuumed constantly

by a mechanical pump and a root pump. Flow rates of the gases are adjusted

by mass flow controllers. The pressure inside the chamber is controlled by an

adaptive pressure controller. This pressure controller is an adjustable valve that

moves in accordance with the pressure inside the chamber to keep the pressure

constant. Pressure is generally of the order of 1 Torr. This low pressure gas is

ionised by an RF antenna which produces radio waves at 13.56 MHz. Reactive

ions deposit on the sample. Thickness of the film is proportional to the growth

time. It is possible to heat the substrate to provide surface mobility for adsorbed

ions. The chamber is vacuumed to a pressure of 10−5Torr by a turbomolecular

pump to evacuate air prior to the operation. Substrates are cleaned by an oxygen

plasma to remove possible organic contaminants before coating.

The films were deposited in two different radial flow capacitively coupled

parallel-plate PECVD reactors. For both reactors chamber pressure was fixed at

500 mTorr and substrate temperature at 250◦C. Deposition time was set sepa-

rately to obtain film thicknesses of 300 or 500 nm. For each film, fused silica,

boron doped p-type silicon and infrared transparent silicon substrates were used.

Table 3.1 lists the the films grown with flow rates of the gases used. Two mixtures

of silane were used. The first is 2% silane in H2 and the second is 2% silane in

N2. H and N series were grown in the same reactor while C series were grown in

another reactor which has a CO2 tank connected.
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Sample Code Flow Rate (sccm)
2% SiH4 in H2 2% SiH4 in N2 N2O CO2

H1 500 - 3 -
H2 500 - 5 -
H3 500 - 6 -
H4 500 - 7 -
H5 500 - 8 -
H6 500 - 9 -
H7 500 - 10 -
H8 500 - 13.5 -
H9 500 - 20 -
H10 500 - 40 -
N1 - 500 3 -
N2 - 500 7 -
N3 - 500 9 -
N4 - 500 10 -
N5 - 500 13.5 -
N6 - 500 20 -
C1 350 - - 10
C2 350 - - 20
C3 350 - - 30
C4 350 - - 40
C5 350 - - 50

Table 3.1: List of samples prepared by PECVD.
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Figure 3.1: Schematic of the PECVD reactor.

3.1.2 Preparation of SiOx by sputtering

Sputtering is a physical vapor deposition method for manufacturing thin films.

Its principle of operation is shown in figure 3.2. Argon gas flows into the growth

chamber and ionized by the RF forming Ar+ ions. These ions are accelerated

under the same electric field hitting the target. Some atoms are removed from the

target by the impact. These are the sputtered atoms and a part of them condense

on the sample. In some cases, sample holder is rotated to obtain a more uniform

film. To make silicon rich oxide thin films silicon and silicon dioxide targets

were used, simultaneously. For insulating targets, DC voltage may cause charge

builtup, for this reason RF voltage was used to sputter SiO2 target. Sputtering

parameters are given in table 3.2.
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Figure 3.2: Schematic of the sputter deposition system.

Base pressure 4.5x10−6 Torr
Working pressure 4 mBar
Process gases Ar 20 sccm H2 4 sccm
Process temperature Room temperature
Time 1 hour
Power (Si) 54 W DC
Power (SiO2) 180 W RF
Film thickness 250 nm

Table 3.2: Sputtering parameters
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3.2 Characterisation of as-grown samples

3.2.1 Composition Analysis by ERDA

Determination of composition is critical for our samples since formation of

nanocrystal depends on the ratio of silicon to oxygen as well as nitrogen and hy-

drogen content. Composition also affects the temperature threshold for nanocrys-

talline formation as we will discuss in the next chapter. PECVD grown films con-

tain H,N and C as well as Si and O making the compositional analysis difficult.

Measuring the hydrogen content in these films is particularly difficult. This is the

main reason of requirement for ERDA. In this section we will discuss the ERDA

measurements and results.

Elastic Recoil Detection (ERD) is an ion-beam technique which allows the

quantitative, compositional depth-profiling of thin films containing light elements.

The strengths of this technique include its ability to combine unambiguous ele-

ment identification, with depth profiling and a direct quantitative result. This is

especially one of the most sensitive methods for the detection of hydrogen, and,

in that sense, an essential technique in our study, since our samples contain H

due to SiH4 and H2 which used as a balance gas to SiH4.

The ERD measurements were performed using 35 MeV Cl+ ion beam at

Helmholtz Zentrum Dresden-Rossendorf, Germany. The ion beam is incident

on the sample at a given angle and the scattered particles are collected by a de-

tector sensitive to the energy of the recoiling ions. Because the amount of energy

transferred to the sample atom depends on the ratio of masses between the ion

and the sample atom, the chemical composition of the sample can be determined

from measuring the energy of scattered elements. The angle between the sample

normal and the incoming beam was 75◦ and the scattering angle 31◦. A Bragg

ionization chamber was used to observe the recoiling ions. This chamber has a

full energy detection circuit to obtain ion energies as well as a fast timing circuit

to obtain a Z dependent signal to separate ion species. Recoiled H-ions were
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detected within a separate solid state detector at a scattering angle of 41◦, pre-

ceeded by a Mylar foil to stop other scattered and recoiled ions. All spectra were

recorded for the same number of incident projectile ions.

The principle of the analysis consist in the fact that the areal density Ni for

the element (i) can be determined from the detector solid angle Ω, the integrated

peak count Ai for Q incident ions, and the cross section σi(E, θ) by the equation:

Ni =
Aicosθ

QΩσi(E, θ)

There are two approaches for the analysis of ERDA data, the first one is the

spectral scaling approach which consists of using interpolation of tabulated re-

coil cross-sections and effective stopping powers to determine the scaling factor

for each channel, then the energy scale is transformed to depth and the counts

converted to concentration [14]. The second approach is the spectral simulation

were some theoretical approximations can lead to relatively fast calculations tak-

ing into account the mass of the target nuclei and the depth of the target nuclei

[15]. The data in this study were fitted using the NDF simulation program [16].

Typical energy spectra for different elements are displayed in Figure 3.3. X-

axis (Channels) indicates the energy of the recoiled ions while y-axis indicates the

number of ions detected at that energy. Each plot shows the energy distibution

of an element. Red lines indicate the theoretical results calculated by simulations

which were fitted to the experimental data.

Simulated energy spectra of the expected atoms are fitted to experimental

spectra. From the intensities of the fitted spectra, atomic percentages are ex-

tracted. Figures 3.4, 3.5, and 3.6 shows the ERDA results for compositional

analysis of our samples. As expected, oxygen content is proportional to flow

rates of N2O and CO2 gases. For all series hydrogen flow rate is fixed and ERDA

shows that hydrogen content is relatively constant, compared to silicon and oxy-

gen contents. For N series, nitrogen mostly comes from the silane mixture (as

well as smaller amount of N2O), therefore almost constant, which is consistent

with the ERDA results. A small amount of carbon (1-2 percent) was found in H
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series which may be due to atmospheric contamination. 2-3 percent carbon exists

in C series, but it does not seem to beproportional to the CO2 flow. According to

the ERDA data, in all off the series, hydrogen content seems to decrease slightly

with N2O or CO2 flow.

Table 3.3 lists the results of the ERDA analysis for all series. The first column

is the sample codes with flow rates. The second column is the measured atomic

density (atoms/cm2). The next 5 colums are atomic percentages of element Si, O,

N, H, C. The last column is the ratio of the sum of oxygen and nitrogen content

to the silicon content. For C series and sputtered samples carbon content is also

included. To obtain sponge-like silicon nanoclusters after annealing, Si/(O+N)

ratio is expected to be close to 1. From the table, the ratio should be 1 between

H7 and H8 for H series, between N4 and N5 for N series, and between C4 and C5

for C series.

Atomic sensitivity of ERDA rapidly decreases as the mass of the element

increases. This may be compensated by the abundance of the said element in the

film to some degree. If the number of counts is low and the data is noisy (See

figure 3.3(d)) than error propagates to elemental ratios of film contents making

the correlation between different analytical techniques not reliable. This method

is sensitive to light elements like hydrogen and not to heavy elements such as

silicon, nitrogen and oxygen, as indicated by the higher noise/signal ratio. In our

case, silicon concentration is very large, the determination of ERDA for silicon is

reliable.

Since ERDA is a sophisticated and expensive technique requiring expensive

technical equipment and hard to reach, we seek alternative approaches for com-

position analysis such as XPS and FTIR. These methods will be examined in the

next sections.
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SiH4:H2/ N2O Density at./cm2 Si (%) O (%) N (%) H (%) C (.%) (O+N) /Si

H1 (500/3) 2380*1015 63 18 3.2 13 3.4 0.34
H2 (500/5) 2380*1015 60 23 4.2 11 1.8 0.45
H3 (500/6) 4500*1015 56 26 4.4 12 1.8 0.54
H4 (500/7) 2760*1015 56 26 5.2 11 1.9 0.56
H5 (500/8) 3170*1015 54 26 5.9 11 2 0.59
H6 (500/9) 2600*1015 52 29 5.8 11 1.9 0.67
H7 (500/10) 3280*1015 51 31 6.1 11 1.6 0.73
H8 (500/13.5) 2040*1015 40 39 9.2 12 0 1.21
H9 (500/20) 2540*1015 38 39 11 13 0 1.32
H10 (500/40) 3100*1015 33 42 12 13 0 1.64

SiH4:N2/ N2O Density at./cm2 Si (%) O (%) N (%) H (%) C (.%) (O+N ) /Si

N1 500/3 2355*1015 47.8 12.4 19.2 20.4 0 0.66
N2 500/7 1717*1015 47 22 16 16 0 0.81
N3 500/9 1667*1015 49 18 17 17 0 0.71
N4 500/10 1336*1015 44 23 17 16 0 0.91
N5 500/13.5 1310*1015 38 34 17 11 0 1.34
N6 500/20 710x1015 34 38 17 11 0 1.62

SiH4:H2/ CO2 Density at./cm2 Si (%) O (%) N (%) H (%) C (.%) (O+N +C) /Si

C1 350/10 1309*1015 55 26 2.1 14 3.5 0.57
C3 350/30 1210*1015 48 38 1.8 8.4 3.8 0.91
C4 350/40 1200*1015 45 42 1.1 7.8 4.1 1.05
C5 350/50 1170*1015 44 43 1.3 7.8 4.1 1.10

Sputter Density Si (%) O (%) N (%) H (%) C (.%) (O+N +C) /Si

Ar only 1980*1015 45 48 1.2 3.2 1.9 1.14
Ar + H2 1380*1015 46 46 1.3 5.2 1.4 1.06

Table 3.3: Compositional analysis of all samples using ERDA
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Figure 3.3: ERDA spectra and simulation (red lines) data for H8 film for hydro-
gen(a), silicon(b), oxygen(c) and nitrogen(d) elements

Figure 3.4: Atomic percentages extracted from ERDA data for H series.
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Figure 3.5: Atomic percentages extracted from ERDA data for C series.

Figure 3.6: Atomic percentages extracted from ERDA data for N series.

26



3.2.2 Composition analysis by XPS

X-ray photoelectron spectroscopy (XPS) is another method for compositional

analysis of thin films. In this method, thin film is irradiated by a focused x-ray

beam causing photoemission of electrons (Figure 3.7).The emitted electrons are

collected by an energy sensitive detector and their binding energy that depends

on the type of the atom and its chemical state, can be determined using the

following equation:

Ebinding = Ephoton − (Ekinetic + φ)

where Ebinding is the binding energy of the electron, Ephoton is the energy of the X-

ray photons being used, Ekinetic is the kinetic energy of the electron as measured

by the instrument and φ is the work function of the spectrometer. Energy of the

emitted electrons is dependent on both the energy of the incident x-ray and the

binding energy of electron to the atom. Binding energy depends on the type of

atom and its chemical state. Therefore analysis of the energy spectrum yields

the elemental concentration and their chemical state information. Photoemitted

electrons come from the top 1 to 10 nm of the material analyzed. XPS is then

a surface chemical analysis technique. To acquire information from the depth

of the sample, during the analysis an argon ion beam is sent to the analyzed

zone to obtain depth profile (Figure 3.8). Unlike ERDA, XPS is not sensitive

to hydrogen content. ERDA analysis shows that the films contain a substantial

amount of hydrogen, therefore atomic concentration results from XPS should be

calibrated according to ERDA results.

XPS spectra were acquired in Koç University, with a Thermo Scientific K-

alpha monochromatic XPS with Al anode. Snap mode acquisition with pass

energy of 150 eV was used. The spectra were energy deconvoluted to increase

resolution before data processing. Flood gun was used for charge compensation,

the base pressure was about 2x10−9 Torr, and experiments were performed under

a vacuum of 2x10−7 Torr. For the depth profiling of the samples, the thin film

surfaces were etch by 1000 eV Ar+ ions. The estimated Ta2O5 benchmark etch

rate under these conditions was 0.50 nm/s. The etching was done azimuthal

rotation to ensure homogenous etching, the etch duration was 10 s with 200
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cycles or more. Figure 3.9 is the analysis of energy spectra of C, N, O and Si

for the sample H7. X axis shows the calculated binding energies, while Y axis

shows the number of electrons counted at that energy. O 1s, N 1s, C 1s and Si 2p

photoemission peaks were recorded and the binding data were referenced to the

aliphatic carbon line at 284.5 eV. The Si 2p peak was deconvoluted into different

Sin+ species. C 1s peak also shows two peaks at 285 and 287 eV corresponding

to C0 and C+. Peak areas were used, with the appropriate sensitivity factors,

to determine the composition of the material. The analysis was done using the

Cofield library (for Al source) from Thermo Scientific.

Since the films contained hydrogen and XPS cannot detect hydrogen, atomic

concentrations may not be determined directly. However, ratios of detectable

elements like silicon, oxygen and nitrogen may yield reasonable values. Figure

3.10, 3.11, 3.12 and 3.13 shows the correlation of XPS and ERDA compositional

analysis for the films grown. In the figures X axis is the N/Si or O/Si ratio from

XPS and Y axis is the same ratio from ERDA. A linear fit with slope close to

1 indicates that O/Si ratio from XPS and ERDA is close, therefore it may be

possible to measure the ratio of oxygen atoms to silicon atoms directly by XPS.

For the case of N/Si ratio, H series have a positive correlation, but N series,

that has the highest nitrogen content, have a negative correlation. C series, that

have low nitrogen content, exhibit a positive correlation between ERDA and XPS

data, but has a large margin of error due to the low N content. Also ERDA is less

sensitive to heavier elements, nitrogen is heavy and its amount in the films is low,

therefore N content from ERDA data is noisy (See figure 3.3(d)). The relationship

between ERDA and XPS for N/Si ratio may depend on overall N content of the

film, but can be better calibrated by analyzing more data to improve signal to

noise ratio. Therefore O/Si and N/Si ratios may be measured by XPS, and if

the hydrogen content is known, atomic concentrations may be calculated as well.

FTIR is sensitive to hydrogen, and may provide clues on hydrogen content of the

films; this will be discussed in the next section.
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Figure 3.8: XPS depth profile. Y axis is the atomic concentrations. X-axis
represents the etched depth of the sample.

Figure 3.7: Schematic explanation of XPS.
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Figure 3.9: Example XPS spectrum. The graphs show clockwise, C 1s, N 1s, Si
2p and O 1s peaks, respectively.
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Figure 3.10: Atomic percentage ratios extracted from XPS compared to ERDA
data for H series. (a) N/Si ratio, (b) O/Si ratio.
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Figure 3.11: Atomic percentage ratios extracted from XPS compared to ERDA
data for C series. (a) N/Si ratio, (b) O/Si ratio.

32



Figure 3.12: Atomic percentage ratios extracted from XPS compared to ERDA
data for N series. (a) N/Si ratio, (b) O/Si ratio.
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Figure 3.13: Atomic percentages extracted from XPS compared to those extracted
from ERDA data for samples prepared by sputtering.
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3.2.3 Composition Analysis by FTIR

Fourier transform infrared spectroscopy (FTIR) is a technique to measure the

absorption and reflection of a material. The molecules inside the films can be re-

garded as oscillators, these oscillators are driven by the electric field of the light.

Light with frequency that matches the oscillator frequency is absorbed. Absorp-

tion spectra yields these oscillator frequencies. From this information it is possible

to get a significant information about the bonding structure. This technique uses

a broadband light source, but the light passes through an interferometer before

the sample. The interferometer transmits some wavelengths and blocks others.

By moving the mirror of the interferometer, an interferogram is obtained. Ac-

tual absorbance spectrum is the Fourier transform of this interferogram. These

spectra are actually a sum of many absorbance peaks that corresponds a different

bonds or different vibrational mode of the same bond, and these peaks should

be identified. We used PeakFit software to analyze the spectra. The software

tries to fit the sum of a number of Lorentzian peaks by changing the width and

intensity of the peaks and minimizing the root-mean-square error. We checked

the frequency shifts and intensities of selected peaks as well as absorbtion inten-

sities and areas. We growed films on double side polished, infrared transparent

silicon substrates. The films we grew contained Si, O, N, H and C. Some of the

peak wavenumbers related to bonds between these element are given in table

3.4.A typical FTIR spectrum of sample H7 is shown in figure 3.14 in the range of

400-4000 cm−1 details of which are as follows: Around 450 cm−1 Si-O-Si rocking

mode and around 650 cm−1 Si-H2 wagging mode, as well as around 850 cm−1

Si-O-Si bending and Si-N3 modes are observed. Si-O stretching mode is observed

around 1050, and Si-H stretching mode is observed around 2000 cm −1 [17, 18].

Prominent features are Si-O and S-N vibrational modes. Concentration of rele-

vant modes and the oscillator strengths of the said modes define the magnitude

of the peaks in the spectrum. It should be noted that the bonding configurations

of modes may vary and this will affect the resonance frequency of the absorption

peak as well as both tensile and compressive stress.
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Absorbance spectra for the films are given in figures 3.15 for the region be-

tween 700 cm−1 -1300 cm−1. The peak close to 1050 cm−1 is due to Si-O-Si

stretching mode, the peak at approximately 805 cm−1 is due to Si-O-Si bending

mode [19, 20], while the peak around 845 cm−1 is due to SiN3 bond [21, 22]. The

peak at 1050 cm−1 is visible in C and N series as well. The 850 cm−1 peak may be

the product of both Si-O-Si and Si-N bonds, but, since it is highest for N series,

which has the highest nitrogen content, and the lowest for C series which has the

lowest N content we can infer that main contribution to this peak comes from

Si-N3 bonds. For N series, intensity of the 850 cm−1 peak exhibit an increasing

trend with increasing silicon content, indicating the availability of N due to high

concentration of balance N in SiH4 gas, as opposed to the decreasing trend ob-

served in H series where N supply is limited by N20 flow rate. However, intensity

of the Si-O-Si bond peak at 1050 cm−1 increases as the silicon content decrease

for all samples. For H series central frequency of this peak decreases as the silicon

content decrease. Figure 3.16 shows the correlation between [O]/[Si] from ERDA

data and stretching peak position at around 1030 cm−1. There is a linear rela-

tionship between [O]/[Si] and peak position. From the fitted line the formula is

[O/Si] = (ωSi−O−Si + 31.4)/1057. Since the x-axis of this data is calibrated with

ERDA data and gives us the correct O/Si ratio. It is possible to determine O/Si

ratio using this formula, if the vibrational frequency of Si-O-Si peak is measured

using IR spectroscopy.

Bonding type Center frequency (cm−1)
Si-O-Si rocking 458
Si-H SiH2 wagging 650
Si-O-Si bending 812
Si-N3 bond 845
Si-O in-phase stretching 1050
Si-O out-of-phase 1150
Si-H stretching 2000-2200

Table 3.4: A list of bond frequencies related to our films.

FTIR is sensitive to hydrogen, and may complement XPS data to determine

at least its presence and variation of hydrogen from sample to sample. Hydrogen
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contributes to the spectra with Si-H, N-H with Si back-bonding (Si-NH) and O-

H with Si back bonding (Si-OH) bonds. Frequency of Si-H wagging mode is at

approximately 650 cm−1, Si-OH and Si-NH frequency is about 3500 cm−1, Si-h

stretching frequency is about 2200 cm−1 (Figure 3.17). A detailed investigation

is needed to correlate hydrogen content and FTIR spectra, but as a preliminary

analysis we can say that the decrease in the intensity of the Si-H wagging mode

peak (Figure 3.18) is correlated to the increase in the intensity of the Si-OH

peak (Figure 3.17(c)). Considering the ERDA data, we can assume that the

hydrogen content of the films are almost constant for H series. Therefore as we

go from H1 to H8, hydrogen is more and more bonded to oxygen with silicon back-

bonding or nitrogen with silicon backbonding. Si-H bonds gradually turn into

Si-O back-bonded hydrogen and Si-N back-bonded hydrogen bonds. In figure

3.17(b), and We can observe that a more complex structure rises in the Si-H

stretching mode region: the spectrum shows several peaks, especially a second

peak at higher frequencies becomes more and more prominent with the increasing

oxygen content of the film. The reason of this tendency of shifting to the higher

frequencies (Figure 3.19) may be the decreasing density of Si-Si bonds. In the

film bonds are not isolated, each silicon atom may be bonded to more than one

type of atom like another silicon, oxygen or nitrogen atom. It exists then different

structural unit denoted as Si(Si4−nOn) with 0<n<4. Silicon is a relatively heavy

atom therefore lowers the frequency of oscillation of Si-H bond. In Si-O-Si bond

Si atoms may be bonded to other silicon atoms and decreasing the silicon ratio

shift the oscillator frequency to higher values. The same trend as in figure 3.19 is

observed for Si-O-Si bending mode, figure 3.20. Increasing N2O flow rate oxidizes

more Si atoms. Si-O bonds that may have other Si atoms backbonded to Si-O-Si

will have their backbonded Si atoms replaced by O increasing the vibrational

frequency of the Si-O-Si bonds.

FTIR measurements could be an affordable alternative for compositional anal-

ysis of PECVD grown hydrogenated oxynitride films, if calibrated by a more direct

method like ERDA. It may be possible to detect hydrogen by FTIR to comple-

ment XPS compositional analysis. To have an accurate calibration, the effect

of all the elements (Si, O, N, H, C) should be discriminated. IR spectroscopy

37



provides important information on the molecular structure of the films used for

formation of Si nanoclusters. Many compositional and configurational parame-

ters may play a role in the formation of Si nanoclusters. Establishing a clear

correlation between all these parameters and the formation of nanoparticles is

beyond the scope of this thesis. Despite the lack of quantitative results, IR spec-

troscopy provides important information as the trends concerning the variations

of different elements. It is possible to determine whether or not a given bond and

hence atomic species remains constant or varies with a process parameter. We

find that Si-H2 wagging mode and Si-H stretching mode frequency are correlated

to the N2O flow rate. We also observed a linear relationship between O/Si ratio

and Si-O-Si stretching peak central frequency.
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Figure 3.14: Example FTIR spectrum. Sample is H7.

Figure 3.15: FTIR spectra of H, C an N series showing the peaks between 700-
1300 nm.
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Figure 3.16: Si-O-Si stretching mode peak position for H series.
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Figure 3.17: FTIR spectra of Si-H wagging mode at 650 cm−1 (a), Si-H stretching
mode at 2100 cm−1 (b) and Si-OH or Si-N stretching mode at 3300cm−1 (c) for
H series. The arrows show the direction of increasing or decreasing H content.
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Figure 3.18: Si-H wagging mode absorbance intensity with respect to oxygen to
silicon ratio for H series.

Figure 3.19: SiH2 stretching mode absorbance central frequency with respect to
flow rate of N2O for H series.
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Figure 3.20: Si-O-Si bending mode absorbance central frequency with respect to
flow rate of N2O for H series.
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ε1 2.5-3.6
A 10-20
B 0.10-0.14
Ec 3.3-4.0

Table 3.5: Typical range of lorentz fit parameters for ellipsometry.

3.2.4 Determination of Optical Properties by Ellipsome-

try

Ellipsometry is a technique to measure optical properties including but not limited

to index of refraction, extinction coefficient and film thickness of thin films. An

elliptically polarized light is incident on the sample and reflected beam is analyzed

to obtain the ratio of the s and p polarized components. From this ratio two

parameters called Ψ and ∆ are obtained. The relationship between Ψ, ∆ and the

reflected intensities is:
Ip
Is

= tanΨei∆

Ip and Is are the ratio of intensity of the incoming and reflected light for p and s

polarised light respectively. The software fits the theoretical Ψ and ∆ values to

the experimental ones by minimizing the root-mean-square error. To calculate

the theoretical Ψ and ∆, a model needs to be defined. This model is composed of

suspected layers of material making up the sample and uses either pre-measured

tables of index of refraction and extinction coefficient of a material or uses a

physical model like Lorentz oscillator [23] for these quantities. Lorentz oscillator

model assumes that the material is a damped oscillator system, the complex

dielectric constant of which is given by;

ε∗ = ε1
AEc

E2
c − E2 − iBE

where A is the amplitude, B is the broadening of the oscillator mode, Ec is the

vibrational energy, ε1 is the offset energy, and E is the energy of the photon.

Expected range of these parameters for SiOx films are given in table 3.5.

For ellipsometric measurements a J. A. Woollam variable angle spectroscopic
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Figure 3.21: Typical raw ellipsometric data with Lorentz oscillator model fit for
silicon rich oxide thin films.

ellipsometer (VASE) with wavelength range 300-1700 nm was used. Angle of

incidence was set generally between 65-75 degrees. We used silicon substrates,

since for some samples grown on quartz, reflection from the uncoated side of

the substrate interfered with the signal. From the ellipsometric measurements

thickness, index of refraction and extinction coefficient was extracted. Typical

experimental and fitted Ψ and ∆ data are shown in figure 3.21. Refractive index

calculated by fitting Lorentz model to experimental data are given in figure 3.22.

In general all refractive indices increase as wavelength gets smaller in accordance

with Cauchy law. Extinction coefficients are given in figure 3.23. The extinction

coefficients also increase at shorter wavelengths suggesting a resonance in the UV.

We further note that increasing the Si content in the films increase the refractive

index as well as the extinction coefficient as expected.

These films can also be regarded as a mixture of SiO2 and Si by effective

medium approximation. The refractive index and extinction coefficient can be

calculated from linear form of effective medium approximation by the formula;

neffective = xnSi + (1− x)nSiO2
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and

keffective = xkSi + (1− x)kSiO2

where x is the ratio of the silicon content, nSi, kSi, nSiO2 and kSiO2 are the re-

fractive index and extinction coefficient of silicon and silicon dioxide. Effective

medium approximation therefore shows that the films richer in silicon has has

refractive index and extinction coefficient closer to the bulk silicon’s. This ex-

plains the increasing trend observed in refractive index and extinction coefficient.

Due to the nitrogen content and high absorption, effective medium approxima-

tion cannot give the composition accurately, however comparing the ERDA data

to refractive index it is observed that SiOx films with x=1 have a refractive index

around 2. Figure 3.22(d) compares the refractive index of hydrogenated and non-

hydrogenated films. Hydrogenated films have lower refractive index as lighter

hydrogen atoms increase the frequency of oscillator. Extinction coefficients also

increase with silicon content in these samples.

We also measured the transmission coefficient at normal incidence by ellip-

sometry of H series 300nm thick films on quartz substrates (Figure 3.24). We

observed that transmitted light at 490 nm is inversely proportional to the refrac-

tive index of the film since the light is reflected more at the interfaces that has a

larger index difference at both sides. The transmission is less for the films that

has higher silicon to oxygen ratio. The transmission coefficient was found to be

between 30% and 85%.

We correlated Si, O, N and H content of the films from ERDA measurements

and the refractive indices at 900 nm (since the index is relatively constant around

900 nm) from ellipsometric measurements using Eureqa software. By fitting linear

coefficients to our dataset, we found an empirical relationship for the refractive

index:

n = 0.05028 ∗H + 0.02732 ∗ Si+ 0.00491 ∗O − 0.01125 ∗N

where H, Si, O and N are the atomic percentages of these elements. Figure 3.25

shows the index values calculated from the formula and and measured by ellip-

sometry. Mean square error is found as 0.00117 (data of sputtered sample are
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excluded). The formula suggests that effect of the hydrogen is high, and pro-

portional to the index. However, we expect hydrogen to decrease the refractive

index, in accordance to figure 3.22(d). The hydrogen content of these films gen-

erally increase as the silicon content increases, according to the ERDA results.

Hence, this relationship may be the applicable to PECVD method only, and may

not be applicable for thin films produced by different methods. Indeed, sputtered

samples (circled in blue) do not exhibit the same correlation.

Figure 3.22: Refractive index as a function of wavelength for different N2O and
CO2 flow rates for H, N, C series and sputtered samples. Flow rates are given in
sccm in the inset. Growth parameters are given in section 3.1.

Growth rates calculated from thicknesses are given in figure 3.26. Growth

rate of N series is relatively constant and around 80nm/min.Growth rates are

higher for N series (SiH4:N2+N2O) than H series (SiH4:H2+N2O), as nitrogen also

contributes to the film growth by forming silicon nitride. C series (SiH4:H2+CO2)

growth speed is lower than H series, probably due to C-O bond enthalpy being

higher than Si-O. Decomposition of CO2 also require more energy than of N2O.

For C and H series, growth rate increase as the film composition gets closer to
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Figure 3.23: Extinction coefficient as a function of wavelength for different N2O
and CO2 flow rates for H, N, and C series. Flow rates are given in sccm in the
inset. Growth parameters are given in section 3.1.

the stochiometric ratio due to the larger number of oxygen ions inside the growth

chamber, however for N series growth chamber may be saturated by nitrogen ions

so that the rate does not change as much. About ten percent fluctuation may be

the result of high growth rate.
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Figure 3.24: Transmission coefficient as a function of refractive index at normal
incidence by ellipsometry of H series on quartz substrates.

Figure 3.25: Observed vs predicted plot of refractive index at 900 nm. X axis is
the values calculated from the formula n = 0.05028H + 0.02732Si+ 0.00491O −
0.01125N . The points circled in blue are data of the sputtered samples.

Figure 3.26: Growth rate of H and C series with respect to N2O and CO2 flow
rates with all other parameters held constant.
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3.3 Conclusion

We have explained the PECVD and sputtering methods for silicon rich oxide

thin film growth. We have listed the growth parameters of 4 series of samples

(Table 3.1 and 3.2): H series (grown by precursor gases SiH4:H2+N2O), N series

(grown by precursor gases SiH4:N2+N2O), C series (grown by precursor gases

SiH4:H2+CO2) and sputtered samples. H, C, and N series are made by varying

the flow rates of N2O or CO2, whereas sputtered samples were grown either by

pure argon or by hydrogenated argon. Therefore composition of each sample

within the series had to be identified. The films were analyzed by possibly the

most accurate method for compositional analysis, ERDA, and the results are

listed in table 3.3. We have shown that lower N2O or CO2 flow rates results in

higher silicon content. N series contains a large amount of nitrogen (about 17%),

H series contains a moderate amount (3-12%) of nitrogen, and C series contains a

small amount (1-2 %) of it. PECVD grown films contains hydrogen between 8%

to 20 %. Sputtered samples have Si/O ratio close to 1, and hydrogenated sample

contains slightly higher amount of hydrogen. Due to limited access of ERDA, we

tried alternative methods like XPS and FTIR. XPS is not sensitive to hydrogen,

but oxygen and nitrogen ratios can be very precisely measured, indeed, O/Si

ratios are close to the ERDA results (Figure 3.10 3.11 and 3.12). N/O ratios can

also be found by calibration of XPS data according to ERDA. We conclude that

if hydrogen content is known thorough an analytical technique such as ERDA,

as in our case, XPS data may yield the full composition. FTIR is sensitive to

hydrogen, hence we propose that FTIR can complement XPS method. We have

shown that IR absorbance intensity and vibrational frequencies of Si-H wagging

mode at 650 cm−1, Si-H stretching mode at 2100 cm−1 and Si-NH and Si-OH

vibrational mode at 3300 cm−1 varies with O content. We also observed that

Si-O-Si stretching mode peak position at 1050 cm−1 is correlated with the O/Si

ratio of the film. Finally we have analyzed the thicknesses, refractive indices

and extinction coefficients of all samples by ellipsometry. We found that both

refractive indices and extinction coefficients increase with silicon content for all

series. We have found the growth rates of the films from the measured thicknesses

and growth times, and observed that growth rates increase with N2O/SiH4 and
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CO2/SiH4 flow rate ratios. It seems that it is also possible to estimate the Si of

the film from refractive index value (Figure 3.25).

Nanoparticle formation critically depends on composition of the film. In this

chapter we have examined the composition and other properties of as grown films.

In the next chapter, we will explain the furnace annealing and laser processing

methods for nanoparticle formation, and focus on the effect of composition on

the Si nanoparticle formation.
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Chapter 4

Nanostructure Formation

For nanoparticle formation, we have processed the Si rich oxide thin films by two

different methods: continuous wave laser processing and thermal annealing. Laser

irradiation was done by varying power densities, while thermal annealing was done

by varying the annealing temperature and time. Formation of Si nanoparticles

was characterized by Raman spectroscopy. Nanocrystal formation threshold was

determined as a function of laser power density and dwell time in the case of laser

annealing and temperature and annealing time, in the case of thermal annealing.

The effect of the composition and hydrogen content on nanocrystal formation

threshold was analyzed. The main purpose of the thermal annealing was to

compare the nanocrystalline Si formation threshold to laser processing method

threshold. Threshold values obtained from laser processing were compared to

thermal annealing. Spatial distribution of nanoparticles on scanned lines were

analyzed by Raman spectroscopy, Dektak and optical microscopy.

4.1 Thermal Annealing

Samples were annealed in an Annealsys SprayCVD-050 rapid thermal processor

up to 1200◦C under 200 sccm argon flow. Annealing steps are as follows:
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Figure 4.1: Schematic diagram of rapid thermal processing system.

Step 1 Purge: 120 sec. 200 sccm Ar flow

Step 2 Moist Removal Temp. Rise Up: 70◦C in 1 sec.

Step 3 Moist Removal: 70◦C for 60 sec.

Step 4 Temp. Rise Up: 520◦C in 5 sec.

Step 5 Temp. Rise Up: 900-1200◦C in 12 sec.

Step 6 Annealing All steps are done under 200 sccm pure argon flow.

This rapid thermal processing system uses a flashlamp to heat the sample (Fig-

ure 4.1). A thermocouple measures the temperature near the sample and a PID

temperature controller applies current to the heater accordingly. Argon gas flows

into the chamber at a specified flow rate. The chamber is constantly vacuumed

to keep the pressure fixed. Chamber walls are cooled by controlled water flow

to prevent overheating. At first, the argon flow removes the oxygen inside the

chamber then a low power is applied to remove moisture. Afterwards, the tem-

perature is increased at a constant rate; to 520 ◦C in 5 sec then to 1200 ◦C in 12
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sec. During the annealing step the temperature is constant. When annealing is

done, the heater is turned off and the sample cools under argon flow.

H series, C series and sputtered samples (on quartz substrates) were annealed

under temperatures between 1000 to 1200 ◦C for different annealing times. The

samples used in this experiment are H7, C3 and sputtered samples (see table 3.1).

These samples were chosen to have a x value of SiOxNyHz closest to 1. After the

deposition of the thin films on the substrates, each sample was annealed at differ-

ent times and temperatures. Formation of the nanocrystalline silicon depends on

both temperature and time and is expected to exhibit an Arrhenius-like behavior

(i. e. the transition rate obeys Arrhenius rate equation k = Ae−Ea/kBT where Ea

is the activation energy, which is the energy needed to form silicon nanocrystals,

kB is the Boltzmann constant and A is a pre-exponential factor that depends on

the reaction. Linear relationship between ln(k) and T−1) is therefore expected.

4.1.1 Raman Characterization

To confirm the formation of nanocrystalline silicon, we used Raman spectroscopy.

Raman spectroscopy is a method used to analyze of the vibrational modes of

molecular and crystalline samples by light scattering. Raman scattering is ba-

sically the inelastic scattering of light from phonons in crystals. Two types of

Raman scattering exist: if during the scattering a phonon is created, this is called

Stokes scattering, if it destroys a phonon, it is called anti-Stokes scattering. The

scattering process conserves both momentum and energy however, photons lose

energy and momentum after Stokes scattering. Momentum lost is equal to the

momentum (h̄k) of the phonon created. Therefore the wavenumber of the created

phonon can be calculated from the formula:

kp = ki − ks

where ki is the wavenumber of the incoming photon, kp is the wavenumber of

the phonon and ks is the wavenumber of the scattered photon.
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A schematic of the experimental setup for Raman spectroscopy is shown in

figure 4.2. For Raman spectroscopy a monochromatic light source is provided by

a laser. The laser beam is focused on the sample using a microscope. Scattered

light is collected by a collection lens. The monochromator has a light entrance slit

on which the laser is focused. Light is dispersed by a grating into its wavelengths

and a CCD measures the intensity of light at certain wavelength intervals.

From a Raman spectrum it may be possible to obtain information about chem-

ical bonds, crystallization, particle size, stress and even temperature. A typical

Raman spectra of processed SiOx sample is shown in figure 4.3. For these mea-

surements, the films were grown on quartz substrates since silicon substrates make

it difficult to distinguish the Raman signal coming from the nanoparticles and the

substrate. In this spectra 4 peaks are observed: crystalline silicon peak between

510-520 cm−1 (bulk silicon TO Raman frequency is 521 cm−1), amorphous silicon

peak around 490 cm−1, and possibly a peak that indicates an intermediate state

between crystalline an amorphous peak at around 500 cm−1. The broad peak

at around 450 cm−1 belongs to the fused quartz substrate as it can be deduced

from the as grown films which have only this broad peak. As-grown films have

only the fused quartz peak in this range. After annealing at the lowest tempera-

ture an amorphous peak is observed. At higher temperatures, intermediate and

crystalline peaks are also observed.

In order to find the threshold for nanocrystal formation, many samples at

different temperatures were annealed in a nitrogen purged furnace for different

times. In these experiments, we measured crystalline transition time by observing

the formation of crystalline silicon peak using Raman scattering (figure 4.3).

We defined the threshold as the annealing time that crystalline peak makes a

visible shoulder in the Raman spectrum. Above this threshold crystalline peaks

intensifies, narrows and shifts towards 521 cm−1. As an example, development of

the Raman peak for sample H7 annealed at 1150 ◦C for different annealing times

is given in figure 4.3. We observe that the as grown sample exhibits a broadband

scattering spectrum, spanning the wavenumber range of 300-500 cm−1 typical of

a quartz substrate, as well as the density of states of the amorphous film (figure

4.3(a)) superimposed onto each other. As the annealing time is increased we
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find a new peak emerging beyond 500 cm−1 superimposed onto the as grown

broadband spectrum (figure 4.3(b-c)). Increasing the annealing time further,

this newly emergent peak becomes more prominent and shifts towards 521 cm−1

(figure 4.3(d)), typical of nanocrystals. Longer annealing times result in full-

fledged Raman line of silicon optical phonon.

Figure 4.5 is constructed using the results of many threshold determination

experiment. It represents the annealing times needed to observe a nanocrystalline

peak in the Raman spectra as a function of the annealing temperatures for four

different types of samples prepared using PECVD and sputtering. Dotted lines

are linear fits to the experimental points. The PECVD grown samples that use

nitrous oxide and carbon dioxide have different amounts of hydrogen in them.

Sputtered samples use pure argon and argon with 25 % hydrogen, to understand

the role of hydrogen on the nanocrystal formation. From the comparison of

hydrogenated and non-hydrogenated sputtered samples, we can directly conclude

that hydrogen lowers the crystallization threshold. We observed that H7 has the

lowest threshold while C3 follows it, and hydrogenated sputtered sample has a

lower threshold than non-hydrogenated sputtered sample. These rates explain

the role of hydrogen. As hydrogen is a light atom, it can move inside the oxide

easily, breaking bonds and catalyzing the phase separation, therefore decreasing

the activation energy for the formation of Si nanocrystals[24, 25]. The order of

hydrogen content in our samples that lead to lower thresholds for nanocrystal

formation is H>C>hydrogenated sputtered>non-hydrogenated sputtered, with

the highest threshold being the last. The inverse of this order is valid for threshold

times, indicating the facilitative role of hydrogen in phase separation.

In the next section we will explain the laser processing method and lastly

compare it to the thermal annealing.
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Figure 4.2: Schematic of Raman spectroscopy setup.

Figure 4.3: A typical Raman spectra of processed SiOx samples.
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Figure 4.4: Raman spectra of sample H7 annealed at 1150 ◦C for different an-
nealing times.
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Figure 4.5: Phase transition diagram for the formation of silicon nanoclusters
obtained from Raman spectra of furnace annealed samples.
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4.2 Laser Processing

Lasers can be used to heat an absorbing material and hence, can be used to crys-

tallize amorphous silicon [26, 27, 28, 29]. Laser processing has some advantages

over furnace annealing. It heats the film locally avoiding the heating of the whole

substrate. It is possible to form micrometer size patterns, and Raman charac-

terization can be done on the same setup. In this study, we scanned different

samples by varying the laser power density. Scanned lines were characterized by

Raman spectroscopy, Dektak profilometer and optical microscopy. In the follow-

ing section, we will discuss the effect of composition of the thin films and laser

power on Si nanoparticle formation.

Laser processing was done by 488 nm line of an argon ion laser. Laser beam

was focused on the samples by an inverted optical microscope. The beam was

expanded before entering the microscope to fully cover the entrance pupil of the

microscope objective for better focusing. Spot size was measured using a silicon

photodetector and by scanning a razor edge over the spot. A dichroic mirror that

reflects 488 nm and transmits longer wavelengths was used to direct laser beam

on the samples and collect the Raman scattered light. Raman spectra of the

scanned lines was taken using the same setup. A monochromator with a CCD

with resolution 2 cm−1 was used to collect data. The laser power was measured

by a calorimetric power-meter. Scanning of the samples under the laser beam

was done by a motor controlled XY stage. A Labview program was written to

control the speed and scanning pattern. In the same setup, optical images were

taken by a in-situ camera. Figure 4.6 is the schematic of the experimental setup.
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Figure 4.6: Experimental setup of laser processing.

61



4.2.1 Scanned Zone Characterization

Figure 4.7 is a typical optical image of the scanned lines. Each line was scanned by

a different laser power density. When nanocrystalline silicon is formed (confirmed

by Raman spectroscopy) generally the effect of the laser is visible on the image.

As laser power is increased, lines become wider and more visible. In figure 4.7, the

power density decreases towards the bottom of the figure except for the lowermost

two which were scanned at higher power densities. We should note that the

appearance of the scanned lines also depends on the substrate. On BK7 glass or

borosilicate glass, laser scan caused formation of cracks and/or bubbles. We used

fused quartz substrates that does not cause these defects.

Figure 4.8 shows Dektak and Raman data of a sample scanned with laser

power densities of 38, 48, 51 and 102 kW/cm2. Connected black dots are normal-

ized intensities of nanocrystalline Raman peaks. Red dots are Dektak profilome-

ter measurements. Optical images in the background were scaled to match the

Dektak profiles. Dektak profiles indicate that scanned lines shrank by a few per-

cent after the laser irradiation. At higher power densities, extra material appears

to be deposited at the sides of the scanned zone. It is well known that PECVD

grown sample contain a lot of voids. This 5 percent shrinking may be a mechan-

ical effect due to the compacting of the atoms to fill the voids. Raman profiles

are consistent with Dektak profiles, nanocrystalline Si peak is observed in laser

scanned zones and nanoparticle formation zone gets wider as the power increases.

At yet higher power densities (Figure 4.9) material deposition to the sides of the

scanned region increases, which may now be due to melting, and nanocrystalline

Si profile exhibits a three-peak structure: Raman intensity is the highest in the

middle and at the edges of the scanned zone, but vanishes away from the scanned

zone. This may indicate formation of three crystalline nanowires and its cause

may be non-uniform heating of laser beam. Thermal gradients may cause Si

atoms to form nanocrystallites at three distinct locations. At this high power the

scanned zone probably melts and some of the silicon atoms tend to diffuse and

crystallize at the cooler edges. As the beam moves forward, the middle of the

scanned zone solidifies the last, causing silicon atoms to remain in this zone and
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solidify in the middle. The origin of this formation needs to be studied further.

We have also laser scanned different lines on the samples by varying the power

density. After scanning, the stage was moved back to the middle of the scanned

line, and Raman spectra was taken at a much smaller laser power density (smaller

than 1kW/cm2) to prevent heating during Raman scattering. Figure 4.10 allows

us to deduce the temporal evolution of the Raman scattering from scanned H3

sample. At low power density, amorphous peak is as visible as nanocrystalline

peak, at highest power density, nanocrystalline peak becomes more apparent and

intermediate state peaks appear. We used PeakFit software to deconvolute the

spectra and identify the peaks. The magenta line in deconvoluted spectra is due

to fused quartz substrate. Cyan lines are due to the crystalline Si peak, dark blue

lines are the amorphous silicon peaks, and the green lines are the peaks due to

intermediate states between amorphous and crystalline Si. As the nanoparticle

formation is expected to have an Arrhenius type reaction rate, at higher temper-

atures the formation rate is expected to be higher. Therefore keeping the dwell

time constant at 1 second and varying the power density, shows the temporal

evolution of nanocrystalline peak formation. At first nucleation occurs but the

precipitated nuclei is not completely crystalized and is not Raman visible. Crys-

tallization occurs gradually in time, and as the nanostructures grows intermediate

states forms [30].

To analyze the role of composition on nanocrystal formation, we have laser

processed samples from H series with different O/Si content. Figure 4.11 and

4.12 shows the effect of the composition on nanocrystalline peak formation. In

figure 4.11, Raman spectra taken from lines with varied power densities of sam-

ples H1, H3, H5 and H7 are shown. Dwell time (beamwidth/scan speed) is 1

second. Crystalline peak becomes more prominent with increasing power den-

sity and shifts to the higher frequencies getting closer to the bulk silicon Raman

frequency shift at about 521 cm−1 for all samples. This shift can be attributed

to increasing crystalline quality and size of the nanocrystals. We note that in

all Raman spectra compressive stress[31] during cooling after the formation of

nanostructure may also contribute to the shift of the Raman peak. We assume
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that the magnitude of the stress is the same in all processed samples, and sam-

ples can be Raman compared. Linewidths are larger than bulk silicon (between

10-17 cm−1 compared to 2.8 cm−1 of bulk). This suggest that nanocrystallites

show a size distribution. The zone that Raman spectra was measured is small,

yet contains various sizes of nanocrystalline silicon particles. These particles with

different phonon frequencies, add up to a wide Raman signal. Figure 4.12 shows

the nanoparticle formation threshold, peak position, signal amplitude and Raman

linewidths with respect to the O content obtained from ERDA results for H se-

ries. Oxygen facilitates nanocrystal formation until the film composition reaches

25 at.% oxygen. It may decrease the activation energy of the formation and speed

up the nanocrystal formation at lower temperatures. Peak position blue-shifts

and linewidths become narrower indicating that nanoparticles are closer to the

bulk like sizes with higher oxygen content, then this trend is reversed as it was

observed in the literature [32]. Raman signal amplitude is also higher indicating

that more of the silicon precipitated into crystalline particles.

Figure 4.13 compares the non-hydrogenated and hydrogenated sputtered films

for nanoparticle formation threshold. Similar to H series films, Raman peak posi-

tion shifts to the higher frequencies with increasing laser frequencies. Threshold

for nanocrystal formation of hydrogenated film is 42 kW/cm2 while threshold for

nanocrystal formation is about 52 kW/cm2 for non-hydrogenated sample. Parti-

cle formation in the non-hydrogenated sample is also more sudden. Figure 4.14

shows the evolution of Raman spectra with increasing power density for sam-

ple C3. This data is consistent with what we obtained from furnace annealing.

Nanoparticle formation threshold of laser processing for different samples and

their hydrogen content are shown in table 4.1. Except for small the shift in the

Raman frequencies between C3 and hydrogenated sputtered sample, the order of

threshold is consistent to the results of furnace annealing (Figure 4.5). In the

thermal annealing method, we had concluded that hydrogen facilitates nanocrys-

talline Si formation in annealed silicon rich oxides. Comparing the threshold

power densities and hydrogen content in table 4.1, we can come to the same

conclusion for samples that were processed with cw laser processing method.
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Figure 4.7: An example of optical microscopy image of laser processed lines.
Dwell time is 1 second.

Sample Threshold power density Hydrogen content (at. %)
H7 35.5± 2 kW/cm2 11
C3 44.5± 2 kW/cm2 8.4
Sputter Ar + H2 42± 2 kW/cm2 5.2
Sputter Ar 52± 2 kW/cm2 3.2

Table 4.1: Nanocrystalline peak formation threshold for laser scanned samples.
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Figure 4.8: Microscope images of the processed lines with Dektak and superim-
posed Raman intensity profiles.

Figure 4.9: Microscope image of high power (215 kW/cm2) processed line with
Dektak and superimposed Raman intensity profile.
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Figure 4.10: Laser power density dependence of Raman spectra of 1 sec laser
processed zone in sample H3.
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Figure 4.11: Raman spectra after processing by various laser power densities for
H series.
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Figure 4.12: Threshold, peak position, signal amplitude and linewidth after laser
processing films with varying oxygen content for H series. Dwell time is 1 seconds.
Power density for (b), (c) and (d) is 40.7 mW/cm2.

69



Figure 4.13: Laser power density dependence of Raman spectra of 1 sec laser
processed sputtered non-hydrogenated (a,b) and hydrogenated (c,d) samples.
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Figure 4.14: Laser power density dependence of Raman spectra for C3 for 1 sec
dwell time laser processing.
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4.3 Conclusion

In this chapter we explained the thermal annealing and laser processing methods

for nanocrystalline Si formation in SiOx. In thermal annealing study, we have

found the nanocrystalline Si formation threshold in terms of annealing times and

temperatures. Nanocrystalline peak formation was detected by Raman spec-

troscopy. We have compared the threshold of samples C3, H7 and two sputtered

samples (one with hydrogen and one without). We have observed an Arrhenius

like relationship between the reaction rate, as represented by the threshold time

to observe the nanocrystalline Si peak at a given temperature. Comparing sput-

tered samples, we observed that the threshold of hydrogenated sample is lower

than the non-hydrogenated one. Therefore, we conclude that hydrogen lowers the

threshold by decreasing the activation energy for the formation of nanocrystals.

Laser density threshold energy for the formation of nanocrystals C3 and H7 is also

lower than sputtered samples and threshold of H7 is lower than threshold of C3.

ERDA results shows that hydrogen content of the films is in the following order:

H>C>hydrogenated sputtered>non-hydrogenated sputtered, with the threshold

for the formation nanocrystalline Si being the highest for the last samples in

the order. This ordering of the samples with respect to their hydrogen content

suggest that the threshold order may be attributed to the hydrogen content. We

have done laser processing using an Ar-ion laser (488 nm) focused in a microscope

and scanned the samples across the laser beam to obtain laser processed lines.

For a fixed dwell time, we have scanned the samples by varying power density.

Similar to the analysis done in the thermal annealing method, we have measured

the thresholds for formation of nanocrystals by Raman scattering. We showed

that the order of the samples with hydrogen content and their threshold times

measured by two different methods are consistent with each other. We showed

that the nanocrystal formation threshold also depends on the oxygen content.

Up to 26 at.% oxygen concentration level in the samples, the threshold decreases.

Higher oxygen content increased the threshold. Increasing oxygen concentration

nanocrystalline peaks enhance the crystal quality measured from Raman peak

frequency and linewidth. We also analyzed the Raman intensity spatially over

the scanned lines. Dektak profilometry indicates that the scanned lines shrink
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by 5 % and Raman peaks are observed on these shrunk zones. To sum up, we

have analyzed the effect of composition, laser power density, annealing time and

temperature on the nanocrystalline silicon formation.
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Chapter 5

Conclusions and future work

We have fabricated silicon rich oxide thin films by PECVD and sputter deposition.

For PECVD, three series was made by different combinations of process gases

(SiH4:H2+N2O, SiH4:N2+N2O, SiH4:H2+CO2). Within each series, N2O and

CO2 flow rates were varied to obtain different films with different compositions.

We have analyzed the composition of thin films grown by PECVD and sputter

deposition methods. For compositional analysis, the main method was Elastic

Recoil Detection Analysis (ERDA), which is an ion-beam method for composi-

tional analysis that is sensitive to light atoms like hydrogen. The ERDA results

for all series were listed in table 3.3. We observed that silicon content decrease as

the N2O or CO2 flow rates increase for PECVD samples. The hydrogen content

was measured between 3 and 20 % for all films. Comparing the samples that

have (O+N)/Si content close the 1 from each series, we observed that the hydro-

gen content order of the sample series is N>H>C>hydrogenated sputtered¿non-

hydrogenated sputtered. Oxygen to silicon ratios of the sputtered samples was

found to be close to 1.

For compositional analysis, X-ray Photoelectron Spectroscopy (XPS) was also

used, as an alternative to ERDA. We found that O/Si ratios from XPS are close

to ERDA results. Due to the noise in ERDA data for nitrogen, N/Si ratios were

noisy, however we observed a linear relationship between ERDA and XPS data for
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this ratio. Therefore ratios of oxygen and nitrogen to silicon can be found from

XPS. If only hydrogen content, which can not be measured by XPS, is known,

overall content of our films can be found.

XPS is not sensitive to hydrogen, but hydrogen bonds are detectable by FTIR.

We observe that central frequencies of Si-H wagging mode at 650 cm−1, Si-H

stretching mode at 2100 cm−1 and Si-N stretching mode at 3300 cm−1 are corre-

lated to the hydrogen content of the films. Therefore it may be possible to extract

the H/Si ratio from FTIR data. It is possible to measure O/Si ratio as well. We

observed that Si-O-Si stretching mode at 1050 cm−1 is linearly correlated to O/Si

ratio obtained from ERDA.

For thickness measurements, we used variable angle spectroscopic ellipsom-

etry. From the thickness information, we calculated the growth rates of each

PECVD grown samples. We measured the index of refraction and the extinction

coefficients from ellipsometric data. A relationship between refractive indices and

Si, O, N, and H content of the film was observed (figure 3.25).

For the formation of Si nanocrystals, we used two methods: thermal annealing

and laser processing methods. Thermal annealing was done by a rapid thermal

processing system under certain annealing temperatures and times. Laser pro-

cessing was done by focusing a 488 nm Ar-ion laser beam on the samples. For

the characterization of nanocrystallization, we used Raman spectroscopy. For a

fixed annealing time we observed that higher temperatures resulted in a better

crystalline quality, observed by the shift of the nanocrystalline Si peak towards

521 cm−1. A similar trend was observed for laser processing. As the power den-

sity of the laser increased, the nanocrytalline Si peak shifted more towards 521

cm−1. Raman peak widths also get narrower as the power density is increased.

For both methods, we observed that hydrogen decrease the temperature or power

density threshold for the formation nanocrystalline Si. We compared the H series

samples that have different O/Si ratios. We observed that oxygen decrease the

power density threshold for nanocrystalline Si formation, up to a certain level (25

% at. concentration). More oxygen than this level resulted in a increase of the

75



power density threshold. We compared the order of laser power density thresh-

old for nanocrystalline Si formation to the time threshold for nanocrystalline Si

formation in thermal annealing method. We found that the order of thresholds

are consistent.

The silicon nanocrystals and silicon crystal networks that are sought after in

this thesis can also be used as excitonic sources for exciton-plasmon interactions.

Confined to very small dimensions, emission efficiency of Si nanocrystals become

very high. As such they can be used on various plasmonic surfaces, such as flat

metal surfaces, uniform gratings and Moire surfaces. The ease and availability

of silicon nanocrystals can provide for the formation of efficient solid state ef-

ficient exciton-plasmon coupling which may eventually lead to the lasing of Si

nanocrystals, a long sought dream.

For application of silicon rich oxides to solar cells, it is neccessary to character-

ize its nanocrystalline structure further. We expect our films to have a sponge-like

silicon nanocrsytal network structure. Transmission electron microscopy of an-

nealed films may provide this information. To confirm the percolated structure,

I-V and photocurrent measurements can be done.
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Appendix A

Comsol Multiphysics Tutorial

In this section we will explain how to model heating of a thin film scanned by a

laser beam. This is an introductory tutorial, yet the model is customizable. One

can adjust the constants and materials to model similar systems. The version

used here is Comsol 3.3a.

1. Run Comsol Multiphysics

2. In the Model Navigator select 3D for space dimensions, then select Ap-

plication Modes⇒Comsol Multiphysics⇒Heat Transfer⇒Convection and

Conduction⇒Transient Analysis, click OK to exit the Model Navigator.

Figure A.1: Constants dialog box
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3. In the Options⇒Constants dialog box enter the constant appropriately.

(Figure A.1)

4. Select Draw⇒Work Plane Settings, in the dialog box select x-y plane z:0

and click OK. Now the screen will be showing the z=0 plane.

5. Select Draw⇒Specify Objects⇒Square. In the dialog box enter 3e-4. In

the Base menu select Center. Click OK. (Figure A.2)This will create a 300

µm square in the z=0 plane. You may want to change the size depending

on your application.

Figure A.2: Square dialog box

6. Select Options⇒Zoom⇒Zoom Extends. This will enlarge the square to fit

the editor screen.

7. Select Draw⇒Specify Objects⇒Line. Fill in the dialog box as shown in

figure A.3. This will create a line in the middle of the square.

Figure A.3: Line dialog box

8. We want the mesh size on the line to be smaller than the rest of the shape.

Select Mesh⇒Free Mesh Parameters. In the Global tab select Coarser in
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the Predefined mesh sizes list. Then go to the Boundary tab and select 4 in

the list. This boundary is the line in the middle and will turn to red now.

Enter maximum element size 1e-6. Click OK.

Figure A.4: Example mesh

9. Select Mesh⇒ Initialize Mesh. The resulted mesh should look like figure

A.4

10. Until now, we worked on a 2D structure. Now we will extrude it to make

a 3D structure. Select Mesh⇒Extrude Mesh. In the geometry tab enter

1e-4 into Distance (Figure A.5). Go to the mesh tab and fill it as shown

in figure A.6. Click OK. This will create a 100 µm thick structure and the

mesh will be denser at the surface.
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Figure A.5: Extrude Mesh dialog box
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Figure A.6: Extrude Mesh dialog box

11. Now we have to define the materials. Select Physics⇒Subdomain Settings.

Hold the CTRL button to select subdomains 1 and 2. Click load. Ma-

terial/Coefficients Library will open. Under the Basic Material Properties

select Silica Glass Click OK. ( FigureA.7)
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Figure A.7: Subdomain Settings dialog box

12. In the Subdomain Settings, we have to define heat source term as explained

in the previous section. Enter the heat source term field the code below.

This will define the heat source term only for the film area. Heat source

term will be zero at the substrate. Figure (A.7)

13. In the Subdomain Settings, go to Init tab, select both 1 and 2, and enter

300 K into T(t0) field. This is the initial temperature. Click OK to exit

Subdomain Settings dialog.
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Figure A.8: Solver Parameters dialog box

14. Select Solve⇒Solver Parameters and fill in as shown in figure A.8.

15. Select Solve⇒Solve Problem.

16. Select Postprocessing⇒Plot Parameters then go to the General tab and

select 0 in the solution at time list.

17. For cross section image, select Options⇒Suppress⇒Suppress Boundaries

and select all boundaries except 6. Click OK. Select Postprocessing⇒Postprocessing

Mode.

18. For temperature profile on the scanned line select Postprocessing⇒Domain

Plot Parameters. Go to Line/Extrusion tab, click Line/Extrusion plot and

select edge 8. Click OK. This will plot all the temperature profiles at the

specified times. You may want to select a specific time from Domain Plot

Parameters⇒General tab.
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